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Information about this document

The warnings and notes in the document mean the following:

A
 WARNING!

Risk of personal injury. Can result in serious injury or 
death. 

A
 CAUTION!

Risk of personal injury. Could result in injury or pose a risk 
to health.

NOTICE!
Risk of damage to property.

Note:
Tips and important information.

Enumerated lists (numbers, letters) are used for:
 ● Instructions that must be followed in a specific sequence

Bullet lists (bullet points, dashes) are used for:
 ● Lists
 ● Instructions comprising only one action
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1 Introduction

1.1 Warranty
The following instructions must be complied with in order for any 
warranty to be applicable regarding functionality and safe opera-
tion of this equipment.

 ● Read these operating instructions prior to operating the prod-
uct.

 ● Use the product only as intended.
 ● Repairs and maintenance must only be carried out by special-
ist technicians or other suitably trained personnel. Only spare 
parts approved by Hermann Sewerin GmbH may be used 
when performing repairs.

 ● Changes or modifications to this product may only be carried 
out with the approval of Hermann Sewerin GmbH.

 ● Use only Hermann Sewerin GmbH accessories for the product.
Hermann Sewerin GmbH shall not be liable for damages re-
sulting from the non-observance of this information. The war-
ranty conditions of the General Terms and Conditions (AGB) of 
Hermann Sewerin GmbH are not broadened by this information.
In addition to the warnings and other information in these Operat-
ing Instructions, always observe the generally applicable safety 
and accident prevention regulations.
The manufacturer reserves the right to make technical changes.
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1.2 Purpose
SeCorr is a system used for correlation.
The SeCorr system can be used for:

 ● Detecting leaks in water pipes

Note:
All descriptions in these operating instructions refer to the system 
as delivered (factory settings). The manufacturer reserves the 
right to make changes.

1.3 Intended use
The SeCorr system is intended for professional industrial and 
commercial use. The appropriate specialist knowledge is re-
quired to operate the system.

Note:
If necessary, learn more about the theory before commencing 
practical work with the system.

The system must only be used for the applications specified in 
section 1.2.
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1.4 General safety information
This product was manufactured in keeping with all binding legal 
and safety regulations. It corresponds to the state of the art and 
complies with conformity requirements. The product is safe to 
operate when used in accordance with the instructions provided.
However, if you handle the product improperly or not as intended, 
the product may present a risk to persons and property. For this 
reason, always observe the following safety information.

Risk of personal injury (health risk)
 ● Handle the components carefully and safely both during trans-
port and when working.

 ● Proceed with extreme caution in the vicinity of electrical lines.

Hazards for the product and other property
 ● Always handle the components with care.
 ● Do not drop the components.
 ● Never set the components in places where they are at risk of 
falling.

 ● It is important that the aerials of the C 200 receiver and the 
RT 200 transmitter do not get damaged.

 − Never bend, kink or cut the aerial.
 − Never carry the C 200 receiver by its aerial.

 ● Before starting work, check that the components are in good 
working order. Never use damaged or faulty components.

 ● Ensure that no dirt or moisture can get into the ports on the 
components.

 ● Always observe the permitted operating and storage tempera-
tures.
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1.5 Radio communication
The SeCorr system uses the following data transmission tech-
nologies:

 ● Near-field radio
 ● SDR (Sewerin Digital Radio)

Near-field radio
The transmitter and receiver communicate by near-field radio. 
The RT 200 transmitter is classed as radio equipment accord-
ing to EU Directive 2014/53/EU. It may, therefore, be subject to 
some use restrictions.

Note:
Users of the SeCorr system are responsible for ensuring compli-
ance with local country regulations regarding the registration and 
use of radio equipment. This applies even if there is an explicit 
licence for a country.

You can find a list of the countries of the European Econom-
ic Area (EEA) where this equipment is licensed for use in sec-
tion 6.8 on page 77.

Note:
Radio systems that use the same frequencies can interfere with 
each other.

 ● Switch off the transmitters when not in use.

SDR radio
Receivers and wireless headphones communicate by bidirec-
tional SDR (SDR: Sewerin Digital Radio). SDR is only used when 
listening to noises.
For more detailed information about the special features of this 
radio connection, please refer to section 3.7.1 on page 38.
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2 SeCorr system

2.1 General information about the system
The SeCorr system works using the correlation method, whereby 
measurements are taken at two fittings (e.g. slide gate, hydrant) 
at the same time. Highly sensitive microphones record the noises 
at the fittings. The two microphones are each connected to a 
radio transmitter. The radio transmitters transmit the signals to a 
receiver – the correlator. The correlator determines the run time 
difference between the signals, i.e. the time lag between the nois-
es reaching the two measuring points. This is then used, together 
with the pipe data, by the correlator to calculate the leak position.
The advantage of the correlation method is that the leak posi-
tion is determined independently of the hearing and experience 
of the user.
The system features a function which can also locate leaks 
acoustically if there is no suitable technology available specifi-
cally for pinpointing or prelocation.

2.2 System components

2.2.1 Overview
SeCorr is a modular system. The main components of the sys-
tems are:

 ● C 200 receiver (correlator)
 ● 2 RT 200 transmitters (1 pair)

 − Transmitter 1 with blue flag
 − Transmitter 2 with orange flag

 ● 2 microphones, e.g.:
 − UM 200 universal microphone

OR
 − HY 200 hydrophone

One microphone is required for each RT 200 transmitter. The 
same type of microphone must always be used for the two 
transmitters.
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 ● F8 wireless headphones (optional)
 ● AC 200 SK 4 case
The system can be transported and stored in the case. The L 
AC/DC adapter can be used to recharge the batteries of the 
C 200, RT 200 and F8 components simultaneously inside the 
case.

Accessories can be added to the system at any time.

Note:
Information about the F8 wireless headphones can be found in 
the relevant operating instructions.

2.2.2 C 200 receiver
The C 200 receiver receives data from the RT 200transmitter. 
The receiver calculates the leak position from the run time differ-
ence between the signals of the two receivers.
The C 200 receiver is also known as a correlator.

2.2.2.1 Setup
Overviews with the names of all the parts of the receiver can be 
found inside the front cover (fig. 1 and fig. 2).
Its symmetrical housing means that it can be operated by both 
right-handed and left-handed users with ease.

Touch screen
The receiver features a touch screen. Certain areas of the touch 
screen are touch-sensitive. Actions are performed by touching 
these areas (buttons).
All of the buttons have a thick, dark grey outline.
Only your finger or a touch pen should be used to operate the 
touch screen.

 ● Always touch the buttons briefly without exerting too much 
pressure.
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NOTICE! Risk of damage
The surface of the touch screen is sensitive.

 ● Do not use any hard or sharp objects to tap the screen.
 ● Protect the touch screen against aggressive substances (e.g. 
acidic or abrasive detergents).

A list of symbols that might appear on the touch screen can be 
found in section 6.2 on page 71.

Light sensor
The light sensor analyses the ambient lighting conditions.
If the automatic brightness setting is enabled, the light sensor 
always adjusts the brightness of the touch screen to the ambient 
lighting conditions.
Information about the automatic brightness setting can be found 
in section 4.4.1.4 on page 55.

ON/OFF key
The ON/OFF key is used to switch the receiver on and off.
Information on switching on and off can be found in section 2.2.2.3 
on page 9.

LED
The LED indicates the operating status.
Information about what the LED signals mean can be found in 
section 6.3.1 on page 73.

Aerial
When using the receiver, the aerial must be pointing upwards 
(fig. 6). It can be folded down for storage in the case.
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Fig. 6: Receiver in its normal position of use
The aerial is pointing upwards.

Ports
The receiver features the following ports:

 ● Charging socket
For recharging the battery.

 ● Microphone socket
For connecting a microphone, e.g. UM 200 universal micro-
phone.

 ● USB port
The USB port is only used by SEWERIN Service staff for main-
tenance work.

Connectors
Carrying systems (Vario, triangle, lap belt, hand loop) can be at-
tached to the connectors.
The connectors are parts of quick-release fasteners.

2.2.2.2 Carrying the system
The receiver is usually carried in front of the body so that the user 
looks diagonally down at the touch screen.
SEWERIN recommends: Use a carrying system for locating op-
erations. The carrying system prevents you from tiring during 
work. It also reduces the possibility of radio interference. Ra-
dio interference can occur if the user accidentally covers certain 
components in the receiver.
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2.2.2.3 Switching the receiver on and off

Switching on
 ● Press the on/off key until the LED turns green.

Switching off
1. Briefly press the on/off key. The Switch offdialog will appear.
2. Tap Switch off device. The receiver will switch off.

2.2.2.4 Automatic power off
The power supply to the receiver is designed in such a way that 
a fully charged battery will allow one full day's work without in-
terruption. However, it is still recommended to conserve energy 
whilst working.
The receiver therefore offers the following automatic power-off 
options:

 ● Switching off the device
The receiver switches off if it is not operated for a specified 
period of time. It must be switched back on again when you 
want to continue work.

 ● Switching off the backlight
The receiver backlight switches off if it is not operated for a 
specified period of time. The receiver remains switched on.

If and when the automatic power off is activated depends on the 
settings (Device menu > General > Switch off device or Switch 
off backlight).
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2.2.2.5 Main view
The touch screen of the receiver displays the main view when 
the system is ready for use.

Fig. 7: Main view

Fig. 8: Results display (detail of main view)

The following is shown in the centre of the main view (fig. 8):
 ● Leak position
Distance of leak from transmitter 1 and transmitter 2

 ● Quality of peak
 ● Duration of measurement
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The main view also contains the following buttons:
 ● Measurement
 ● File
 ● Transmitter
 ● Pipe sections
 ● Filter
 ● Settings

These buttons can be used to open submenus. Most of the but-
tons also display information. The information displayed depends 
on the situation.

Measurement
The Measurement button is divided into different sections. The 
appearance of the Measurement button depends on what the 
program is doing (fig. 9).

 ● Start measurement button
OR
Stop measurement button

 ● Reset button

 

 

Fig. 9: Measurement button at various stages of the program
Top image:  A measurement can be started.
Centre image: A measurement can be stopped.
Bottom image: The calculation data must be reset before a meas-

urement can be started.

For more detailed information on performing measurements, 
please refer to section 3.4 on page 25.
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File
The File menu is opened by pressing the Filebutton. The follow-
ing actions can be performed in this menu:

 ● Save measurement
 ● Load saved measurement
 ● Delete saved measurement

Fig. 10: File button

For information about saving, loading and deleting measure-
ments, please refer to section 3.4.3 on page 27.

Transmitter
The Transmitter button displays the following information:

 ● Current noise level of the transmitters
 − Left: Transmitter 1 (blue)
 − Right: Transmitter 2 (orange)

Fig. 11: Transmitter button

The Transmitter menu is opened by pressing the Transmitter 
button. The following settings can be made in this menu:

 ● Transmitters from which noises can be heard through head-
phones

 ● Volume of noise on headphones
Information about the two transmitters is also displayed.
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For more detailed information about the Transmitter menu and 
listening to noises, please refer to section 3.7 on page 38.

Pipe sections
The Pipe sections button displays the following information:

 ● Total length of measuring section
 ● Number and length of pipe sections
 ● Marker
Indicates the leak position in the pipe section concerned.

 

Fig. 12: Pipe sections button, here: Measuring section with three pipe 
sections
Top image:  Before starting a measurement.
Bottom image: After starting/stopping a measurement

The Pipe sections menu is opened by pressing the Pipe sec-
tions button. The following settings can be made in this menu:

 ● Number of pipe sections in a measuring section
 ● Pipe data for every pipe section

 − Material
 − Diameter
 − Length
 − Sound velocity

For more detailed information about configuring the pipe sec-
tions, please refer to section 3.3 on page 22.
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Filter
The Filter button displays the following information:

 ● Correlation curve
 ● Marker
Corresponds to the leak position.

Fig. 13: Filter button

The Filter menu is opened using the Filter button. This menu 
allows you to optimise the correlation result using filters.
For more detailed information on filters, please refer to sec-
tion 3.5 on page 31.

Settings
The Settings button displays the following information:

 ● Interference suppression setting
 ● Number of calculations
 ● Connected components and information about the charge of 
the relevant batteries

Fig. 14: Settings button
1 Interference suppression, 2 Calculations
3 Components and charge of relevant batteries
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The Settings menu is opened using the Settings button. The 
following settings can be adjusted in this menu:

 ● Measurement
 ● Device

For more detailed information on the Settings menu, please refer 
to section 4 on page 45.

2.2.2.6 How interference suppression works
The interference suppression function allows you to exclude nois-
es from the correlation that may have a negative effect on the 
result (e.g. sound interference from passing vehicles).
How interference suppression works depends on the settings 
(Measurement menu > General).

  
Fig. 15: Interference suppression (detail of Settings button)

Left image:  High interference suppression
Centre image: Low interference suppression
Right image:  Interference suppression off

Whenever interference suppression is active during a measure-
ment, the interference suppression symbol turns red on the Set-
tings button.

Fig. 16: Interference suppression active, here: with low interference sup-
pression setting
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2.2.3 RT 200 transmitter
The RT 200 transmitters send the measurement data from the 
microphones to the C 200 receiver. The transmitters are always 
used in pairs.
The two transmitters are marked with a number and a colour to 
make them distinct.

 ● Transmitter 1 with blue flag
 ● Transmitter 2 with orange flag

Note:
The C 200 receiver uses the same number and colour assign-
ment, e.g. when displaying results.

2.2.3.1 Setup
Lists with the names of all the parts of the transmitter can be 
found inside the front cover (fig. 3 to fig. 5).

Ports
The transmitter features the following ports:

 ● Charging socket
For recharging the battery.

 ● Microphone socket
For connecting a microphone.

Filter key

Note:
The SeCorr system has filter options for various purposes. An 
overview of these can be found in section 2.3 on page 20.

The bandpass can be adjusted using the filter key. A bandpass is 
a filter that only allows signals through from a certain frequency 
range.
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This function can be used to adjust the noise transmission to the 
current situation. For example, when performing correlation on 
plastic pipes, the quality of the measurement can be improved if 
necessary using the low pass setting.
The options are:

 ● Low pass
f

Allows all signals below a limit fre-
quency through. Blocks any signals 
above the limit frequency.

 ● Default
f

Allows all signals through.

 ● High pass
f

Allows all signals above a limit fre-
quency through. Blocks signals below 
the limit frequency.

There is an LED next to each symbol. The LED of the set band-
pass turns green.
The RT 200 always switches to the Default setting when switched 
on.

Light key
The light key is used to switch the light source of the UM 200 
universal microphone on and off.

LED
The LED indicates the operating status.
Information about what the LED signals mean can be found in 
section 6.3.2 on page 74.

Aerial
There is a knob at the top end of the aerial for convenient carry-
ing of the transmitter.
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2.2.3.2 Switching the transmitter on and off

Switching on
The transmitter automatically switches on as soon as a micro-
phone is connected.

Switching off
The transmitter automatically switches off as soon as the micro-
phone is disconnected from the transmitter.
For more detailed information about the plug connection between 
the microphone and the transmitter, please refer to section 2.4 
on page 20.

2.2.4 Microphones
The microphones record noises at the measurement locations. 
This data is then sent to the transmitters via cable.
The system can be used with different microphones. One micro-
phone is required for each RT 200 transmitter. The same type of 
microphone must always be used for the two transmitters.

2.2.4.1 UM 200 universal microphone
The UM 200 is a highly sensitive microphone for picking up struc-
ture-borne noise.

NOTICE!
The UM 200 features a component which is susceptible to dam-
age from adverse forces.

 ● Never drop the microphone.

Accessories can be attached to the UM 200, e.g. a contact adapt-
er. The right accessories can be used to secure the microphone 
at various measurement locations.
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A
 CAUTION!

Danger when using the contact adapter
The contact adapter contains a strong magnet.

 ● Keep the contact adapter away from magnetic storage 
media (e.g. hard drives, credit cards) and medical de-
vices (e.g. pacemakers, insulin pumps).

Note:
The contact adapter comes with a protective screen,

 ● which should be removed before first use.

The microphone features a light source which can be used to il-
luminate the measurement location (torch function).

A
 CAUTION! Risk of glare

The light source comprises two powerful LEDs.
 ● Do not look directly into the light.
 ● Never shine the light into the eyes of another person.

2.2.4.2 HY 200 hydrophone
The HY 200 hydrophone records noises directly from the water 
column.

A
 CAUTION! Risk of contamination

The HY 200 is designed for use in drinking water net-
works.

 ● Always disinfect the HY 200 before use.
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2.3 Filter options (overview)
Filters can be used both on the transmitter and the receiver. Fil-
ters are used for different purposes.

 ● RT 200 transmitter
 − The bandpass can be adjusted using the filter key. This set-
ting determines the extent to which incoming signals are 
sent to the receiver (section 2.2.3.1).

 ● C 200 receiver
 − The correlation result can be optimised using filters (sec-
tion 3.5).

 − A blocking filter can be used to minimise the effects of cur-
rent-carrying electrical lines on the noise (section 4.3.1.4).

 − Date filters can be set in the list of saved measurements 
when searching for specific measurements (section 3.4.3.1).

2.4 Plug connection between microphone and RT 200 
transmitter
The plug connection is coded. For clarity, the following are each 
marked with a red dot:

 ● Plug on microphone cable
 ● Microphone socket on RT 200 transmitter

Connecting the microphone
 ● Align the two red dots with each other. The plug can be inserted 
into the microphone socket.

Disconnecting
 ● Pull back the cover on the microphone plug. This will release 
the connection. The microphone cable can now be removed.
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2.5 Power supply to the components
The following components are powered by a special, inbuilt re-
chargeable lithium-ion battery.

 ● C 200 receiver
 ● RT 200 transmitter

The F8 wireless headphones come with a rechargeable NiMh 
battery.
For information on charging the batteries, please refer to sec-
tion 5.1 on page 58.

NOTICE! Risk of damage when changing lithium-ion bat-
teries
The battery compartments of the components contain parts that 
could get damaged when the batteries are being replaced.

 ● Only SEWERIN service personnel or other authorised special-
ists may replace rechargeable lithium-ion batteries.

A
 WARNING! Risk of explosion due to short circuit

Faulty lithium-ion batteries can explode due to an internal 
short circuit.

 ● Do not send components with a faulty lithium-ion bat-
tery.
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3 System in use

3.1 Preparing the system
Two suitable measurement locations must be found depending 
on conditions on the ground. Suitable measurement locations 
include, for example, fittings or the pipe itself.
1. Attach a microphone to each of the measurement locations.

 − The same microphone type must be used at the two meas-
urement locations.

2. Connect each of the microphones to an RT 200. The RT 200s 
will switch on automatically.

3. Switch on the C 200 receiver. The system is ready for use.

3.2 Measurement steps (overview)
Once the system has been prepared, location can begin.
A measurement comprises the following steps:
1. Configuring the pipe sections (section 3.3 on page 22)
2. Starting a measurement (section 3.4.1 on page 26)
3. Stopping a measurement (section 3.4.2 on page 27)
4. Selecting and adjusting filters  

(optional) (section 3.5.2 on page 35)
5. Saving a measurement  

(optional) (section 3.4.3 on page 27)

3.3 Configuring the pipe sections
A measuring section can comprise one or more pipe sections. 
Each pipe section is characterised by its pipe data. New pipe 
sections are automatically assigned values from the Pipe data 
(Default).
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Note:
The quality of the correlation result depends greatly on the con-
figuration of the pipe sections.

 ● Make sure you configure the pipe sections completely and cor-
rectly in accordance with the conditions on the ground.

 ● Adjust the settings before starting the measurement.  
Any changes made after the start of a measurement will mean 
that it will not be possible to continue the measurement after-
wards.

The main view is open.
1. Tap the Pipe sections button. The Pipe sections menu will 

appear.

Fig. 17: Pipe sections menu
Top: Diagram of pipe sections, here: measuring section 

with two pipe sections, 2nd pipe section selected 
(highlighted blue)

Top right: Add button
Centre: Pipe data from the selected pipe section

2. Set the number of pipe sections (section 3.3.1).
3. Adjust the pipe data for every pipe section (section 3.3.2).

3.3.1 Setting the number of pipe sections
A measuring section consists of:

 ● at least one pipe section
 ● a maximum of five pipe sections
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3.3.1.1 Adding a pipe section
The first pipe section is set on transmitter 1.

 ● Up to four more pipe sections can be added between the first 
pipe section and transmitter 2.

 ● New pipe sections are added to the right of the selected pipe 
section.

The Pipe sections menu is open.
1. Tap on the pipe section beside which you want to add a new 

pipe section. The pipe section will be highlighted in blue.
2. Tap on the Add button. A new pipe section will be added.

Note:
Adjust the pipe data for the new pipe section (section 3.3.2).

3. Apply the settings by pressing Confirm. The receiver will 
switch back to the main view.

3.3.1.2 Deleting a pipe section
Pipe sections can be deleted.
The last remaining pipe section cannot be deleted. The pipe 
data for it, however, can be reset to the default values by going 
through the deletion process.

The Pipe sections menu is open.
1. Tap the pipe section to be deleted. The pipe section will be 

highlighted in blue.
2. Tap the selected pipe section again. The pipe section will be 

deleted without any further confirmation prompt.
3. Apply the settings by pressing Confirm. The receiver will 

switch back to the main view.
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3.3.2 Adjusting the pipe data
Pipe sections are characterised by the following features:

 ● Length of pipe
 ● Diameter of pipe
 ● Pipe material
 ● Sound velocity in the pipe section

Adjoining pipe sections in a measuring section can have differ-
ent pipe data.
New pipe sections are automatically assigned values from the 
Pipe data (Default). The values must then be adjusted according 
to the conditions on the ground.
For more detailed information about the selection options and 
value ranges, please refer to section 4.3.3 on page 52.

The Pipe sectionsmenu is open.
1. Tap the pipe section for which you want to adjust the pipe 

data. The pipe section will be highlighted in blue.
2. Adjust the pipe data.
3. Apply the settings by pressing Confirm. The receiver will 

switch back to the main view.

3.4 Performing a measurement
Each measurement must be started manually and stopped at a 
suitable time.
Once a measurement has been stopped, it can be saved, con-
tinued or repeated.



26 │ 3 System in use

3.4.1 Starting a measurement

Note:
The quality of the correlation result also depends on the general 
noise level at the start of a measurement.

 ● Wherever possible, try to start a measurement when there is 
no loud sound interference in the background (e.g. no passing 
vehicles, extraction from house connections).

The main view is open. The Start measurement button is vis-
ible (fig. 9, image above).

 ● Tap the Start measurement button when the general noise 
level is suitable. The measurement will start. The Stop meas-
urement button will appear.

3.4.1.1 Starting the measurement after configuring pipe sections
Once the pipe sections have been configured, the calculation 
data must be reset before a new measurement can be started.

The main view is open. The Start measurement button is not 
visible (fig. 9, image below).

1. Tap the Reset button. The Start measurement button will 
appear.

2. Tap the Start measurement button when the general noise 
level is suitable. The measurement will start. The Stop meas-
urement button will appear.

3.4.1.2 Continuing measurement
Measurements can be continued under the following conditions:

 ● The measurement has been stopped.
 ● The pipe sections have not been changed.
 ● The calculation data has not been reset.

To continue the measurement, it must be restarted.
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 ● Tap the Start measurement button when the general noise 
level is suitable. The measurement will start. The Stop meas-
urement button will appear.

3.4.1.3 Repeating a measurement
Measurements can be repeated under the following conditions:

 ● The measurement has been stopped.
 ● The pipe sections have not been changed.

To repeat a measurement, it must be restarted.
1. Tap the Reset button. The Start measurement button will 

appear.
2. Tap the Start measurement button when the general noise 

level is suitable. The measurement will start. The Stop meas-
urement button will appear.

3.4.2 Stopping a measurement
Ongoing measurements can be stopped at any time.
In order to achieve a reliable result, SEWERIN recommends: Not 
stopping the measurement until the marker, leak position and 
quality of the peak stop changing.

The main view is open. A measurement is ongoing.
 ● Tap the Stop measurement button. The measurement will 
stop. The Start measurement button will appear.

Stopped measurements can be saved or continued.

3.4.3 Saving a measurement
Measurements can be saved. Approximately 70 measurements 
can be saved.
A message will appear when the memory is full. Measurements 
can be deleted from the memory to free up space. For informa-
tion about deleting saved measurements, please refer to sec-
tion 3.4.3.2 on page 30.
Saved measurements are indicated by:

 ● Date (day and time measurement was saved)
 ● optional: Remark
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The main view is open. The measurement was stopped
1. Tap the File button. The File menu appears.
2. Tap the Save button. The Comment menu appears.
3. Measurements can be saved with or without additional infor-

mation.
 ● Tap Confirm to save the measurement without additional 
information.

OR
a) Enter a comment using the virtual keyboard.

The comment can be up to a maximum of 25 characters 
long.

b) Tap Confirm to save the measurement with additional in-
formation.

The receiver will switch back to the main view.

3.4.3.1 Loading a saved measurement
Saved measurements can be loaded from the memory. Informa-
tion about the measurement can also be displayed. 

Note: 
Only one measurement can be loaded at a time.

The main view is open.
1. Tap the File button. The File menu appears.
2. Tap the Load button. This Load menu will appear.
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Fig. 18: Load menu
Top left: Filter by date button
Centre: List of saved measurements

3. Tap the relevant measurement in the list. The measurement 
will immediately appear in the main view.

Searching for saved measurements
Date filters can be set in the list of saved measurements to search 
for specific measurements.
The following date filters are available:

 ● Year
 ● Year and month

The Load menu is open.
1. Tap the Filter by date button on the top left. The Filter by 

date menu will appear.
2. Set the values for the search.

 − Left-hand field: Year, right-hand field: Month
 − Any means that no date filter will be set.
 − Only values that have been saved for the data are available 
for the search.
Example:
Measurements were saved in 2013 and 2015. No measure-
ments were saved in 2014. The filter criteria available for 
selection are: Any, 2013, 2015.

3. Apply the filters by pressing Confirm. The receiver will switch 
back to the Load menu.
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The list will show all the measurements that match the search 
criteria. The date filter settings are displayed on the Filter by 
date button.

 
Fig. 19: Filter by date button

Left image: No date filter set
Right image: Date filter set (year: 2015, month: 01 January)

3.4.3.2 Deleting a saved measurement
Saved measurements can be deleted individually. To do this de-
lete mode needs to be enabled.

NOTICE! Risk of data loss
In delete mode, measurements are deleted immediately without 
a confirmation prompt.

 ● Work with extreme care in delete mode.

The main view is open.
1. Tap the File button. The Archive menu will appear.
2. Tap the Load button. This Load menu will appear.
3. Tap the Clear button. Delete mode is enabled. The dot on 

the Clear button turns red. The measurements in the list ap-
pear in red.

4. Tap the measurement you want to delete in the list. The meas-
urement will be deleted immediately without further prompt-
ing.

5. Finally, disable delete mode.
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 ● To do this, tap the Clear button again. Delete mode is disa-
bled. The dot on the Clear button turns grey again. The 
measurements in the list appear in black.

OR
 ● Tap Back.

3.5 Optimising the correlation result using filters

Note:
The SeCorr system has filter options for various purposes. An 
overview of these can be found in section 2.3 on page 20.

Filters can help optimise the correlation result and thus locate 
leaks more reliably. Filters are set in the frequency graph.
A well-applied filter will have the following effect on the correla-
tion curve:

 ● Peaks will be displayed in higher quality, i.e. sharper, with 
steeper sides, etc.

 ● The peak of a potential leak noise will be accentuated com-
pared to other noises (e.g. sound interference).

Aim of optimisation
The aim is to obtain the highest quality peak possible in the cor-
relation curve.
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3.5.1 Filter menu (overview)
The Filter menu displays the frequencies, correlation curve and 
the result of the measurement as a graph.

Fig. 20: Filter menu
Top: Frequency graph
Centre: Correlation curve
Bottom: Result of measurement and quality of peak
Right (top to bottom): Lower filter limit, upper filter limit, 

current filter buttons

Available filters
Various filters can be applied.
The options are:

 ● Auto 1 Automatically calculated filter 1

 ● Auto 2 Automatically calculated filter 2

 ● Manual Manually set filter

The symbol of the active filter is displayed on the Current fil-
terbutton.
Manually set filters are saved with a measurement.
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3.5.1.1 Frequency graph
The receiver displays the spectra of the noises in the frequency 
graph.

Fig. 21: Frequency graph
1 Lower stopband, 2 Lower filter limit, 3 Graph of functions,
4 Passband, 5 Upper filter limit, 6 Upper stopband,
7 Frequency axis

In the settings you can specify whether to display one or two 
functions (Measurement menu > Filter basis).
If two functions are displayed:

 ● Areas in which the two functions overlap are shown in black.
 ● If the values of one function are lower than the values of the 
other function across the whole frequency range, you will only 
be able to see the function with the higher values and the 
overlap.

One filter is always set in the frequency graph. This filter can be 
changed.

 ● The filter currently applied will be shown on the Current filter 
button.

 ● The values of the filter limits will be specified on the Lower 
filter limit and Upper filter limit buttons.
Dashes will be shown instead of digits if an automatic filter cal-
culates the entire frequency range as the passband.
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3.5.1.2 Correlation curve
The run time difference between the signals of the two transmit-
ters is displayed in the correlation curve.

Fig. 22: Correlation curve with marker (red rectangle)

The area around the highest peak of the curve is marked with a 
red rectangle. This marker indicates the calculated leak position.
If a correlation curve shows several significant peaks, a plausibil-
ity check should be carried out (section 3.6).

3.5.1.3 Quality of peak
The sharper or clearer the peak, the better the quality. The quality 
can be improved by setting filters.
The quality of a peak is rated by dots. The more black dots, the 
higher the quality.

 
Fig. 23: Quality of peak

Left image: Very high quality
Right image: Poor quality

Note:
The quality of a peak does not correlate to the accuracy of the 
calculated leak position.
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3.5.2 Selecting and adjusting filters
One filter is always set in the frequency graph when the Filter 
menu is opened. Whether an automatically calculated filter or a 
manually set filter is applied first depends on the starting point. 
Once the menu has been opened, you can switch between filters.
Automatic filters are always recalculated when the Filter menu 
is opened.

Opening the filter menu

The main view is open.
 ● Tap the Filter button. Wait until the Filter menu appears.

Note:
Any ongoing measurements will be stopped when the Filter 
menu is opened.

3.5.2.1 Selecting automatically calculated filters

Note:
Filters Auto 1 and Auto 2 are identical if the calculation algo-
rithms on which they are based do not detect any differences.

The Filter menu is open.
 ● Repeatedly tap the Current filter button. If the Auto 1 or 
Auto 2 symbol appears, automatically calculated filter 1 or 2 
will be applied.
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3.5.2.2 Manually adjusting filters
There are two ways of manually adjusting the filter limits:

 ● Quick adjustment
 ● Exact adjustment

Performing a quick filter adjustment
A quick adjustment involves resetting both filter limits.

The Filter menu is open.
1. Tap the frequency graph (fig. 21)

 − as accurately as possible.
The Filter menu will change its appearance (fig. 24). The first 
filter limit is set.

Fig. 24: Filter menu – quick adjustment

2. Tap the frequency graph a second time.
 − The higher of the two tapped frequency values will be as-
signed to the upper filter limit.

The Filter menu will return to its default view (fig. 20). The 
second filter limit is set. The Manual symbol is visible on the 
Current filter button.

Performing an exact filter adjustment
When performing an exact adjustment, the upper and lower filter 
limits are set independently of each other. The filter limits can be 
moved in very small increments.
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The Filter menu is open.
1. Tap either the Lower filter limit or the Upper filter limit but-

ton.
The Filter menu will change its appearance (fig. 25). The 
stopband of the filter limit that can be adjusted is shown in 
orange.

Fig. 25: Filter menu – exact filter adjustment, here: adjusting the 
lower filter limit

2. Reset the selected filter limit.
 − Tap the frequency graph to roughly set the filter limit.
 − To set the filter limit exactly, keep tapping one of the Move 
buttons until the desired position has been reached.

Ensure that the upper and lower filter limits do not overlap.
3. Apply the filter limit by tapping Confirm. The Filter menu will 

appear again in its default view (fig. 20). The Manual symbol 
is visible on the Current filter button.

4. If necessary, repeat all the steps for the other filter limit.

3.5.2.3 Applying the filters (exiting the Filter menu)
The settings can be applied once the filter limits have been ad-
justed.

The Filter menu is open.
 ● Tap Back. The filter settings will now be applied. The receiver 
will switch back to the main view.
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3.6 Plausibility check (moving the marker)
The correlator cannot determine whether there is an actual leak 
at a calculated position or whether the noise is interference (e.g. 
open house connection).
This can pose a problem if the correlation curve shows more than 
one significant peak. In such cases, we recommend checking the 
plausibility of the correlation result.

The Filter menu is open.
1. Move the marker in the correlation curve to another peak.

 − To do this, tap the relevant position in the curve.
2. Read off the recalculated leak position.
3. Check the conditions on the ground.

 − Is there another noise source at the calculated position?

3.7 Listening to noises

Note:
F8 wireless headphones are required for listening to noises.

3.7.1 Information about the radio connection during listening
The C 200 receiver and F8 wireless headphones communicate 
by bidirectional SDR (SDR: Sewerin Digital Radio).
SDR transmits uncompressed signals in real time. Radio inter-
ference can, therefore, cause a short clicking noise in the head-
phones.
SDR uses the same frequency ranges as, for example, WLAN 
or Bluetooth. In rare cases, SDR can, therefore, be affected by 
other radio connections.
These effects can be minimised by the following measures:

 ● Avoid drops in the SDR radio connection caused by obstruc-
tions, e.g. your own body. Carry the receiver in such a way 
that the transmission path to the headphones is not obscured.
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 ● If you are carrying electronic devices that use WLAN and Blue-
tooth directly on your body: Disable the WLAN and Bluetooth 
function if necessary.

3.7.2 Transmitter menu (overview)
The Transmitter menu displays information about the transmit-
ters connected by radio.
The following noise settings can be adjusted:

 ● Volume on the headphones
 ● Transmitter selection

The microphone function can be opened if a microphone is con-
nected to the receiver.

Fig. 26: Transmitter menu without a connected transmitter

Fig. 27: Transmitter menu with connected transmitters
Top: Volume
Centre: Transmitter selection
Left/right: Information about transmitter 1/2
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Information about the transmitters
The following information appears as soon as an RT 200 trans-
mitter is connected:

 ● Strength of radio signal at receiver
 ● Current noise level at transmitter
 ● Battery charge
 ● Bandpass setting

Information about the GPS position of the transmitter is not cur-
rently in use for technical reasons.

   
Fig. 28: Information about the transmitter, here: Transmitter 1 

From left to right: Radio signal, noise level, rechargeable battery, 
bandpass

Note:
The information is not constantly updated as radio transmission 
of the noise takes precedence. It can sometimes take up to 20s 
for changes to be displayed.

3.7.3 Adjusting the volume
The volume determines how loudly the noises are played back 
through the headphones.

A
 CAUTION! Health hazard

Excessive noise can cause damage to hearing and result 
in irreversible health problems.

 ● Always adjust the volume to the current situation.
 ● Choose as low a volume as possible.
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The main view is open.
1. Tap the Transmitter button. The Transmitter menu will ap-

pear.
2. Adjust the volume by tapping either:

 − the volume symbols
 − in the area between the two volume symbols

Fig. 29: Adjusting the volume

3. Apply the settings by pressing Confirm. The receiver will 
switch back to the main view.
The settings are stored until they are next adjusted.

3.7.4 Selecting a transmitter
The noises from the two measuring points can be listened to 
together or separately.
The options are:

 ● Noises from transmitters 1 and 2

 ● Noises from transmitter 1

 ● Noises from transmitter 2

 ● No noise
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The main view is open.
1. Tap the Transmitter button. The Transmitter menu will ap-

pear.
2. Tap the relevant transmitter selection. The setting is applied 

immediately.
The setting is stored until it is next adjusted.

3.8 Microphone function for acoustic leak detection
The microphone function is an extra function on the C 200 re-
ceiver.
The microphone function can be used to listen to noises directly 
at a measurement location. It can be used when there is no suit-
able technology available specifically for pinpointing or preloca-
tion.

Note:
The microphone function cannot be used for correlation.

The following system components are required for acoustic leak 
detection:

 ● C 200 receiver
 ● Microphone, e.g. UM 200 universal microphone
 ● F8 wireless headphones

3.8.1 Microphone menu (overview)
A measurement to listen to noises can be performed in the Mi-
crophone menu. The results of the measurement are displayed 
in a graph and as numerical values.

Note:
The Microphone menu can only be opened when a microphone 
is connected to the receiver.
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Fig. 30: Microphone menu

Fig. 31: Display of measurement values (detail of Microphone menu)
1 Current minimum noise level
2 Current noise level
3 Previous minimum noise level

The following measurement values are displayed (fig. 31):
 ● Current noise level
 ● Current minimum noise level
 ● Previous minimum noise level

The Microphone menu also contains the following buttons:
 ● Volume
 ● Light
 ● Listen to microphone
 ● Turn off noise

The volume for the microphone function (Microphone menu) is 
independent of the volume for listening to noises (Transmitter 
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menu). The volume must be set separately in the two menus. The 
setting procedure is identical.
The Light button can be used to switch the microphone’s light 
source on and off.

3.8.2 Performing a noise measurement
The current noise level is always displayed in the Microphone 
menu. However, the noises can only be heard once a measure-
ment has started.

The receiver is switched on. The main view is open.
1. Connect a microphone (e.g. UM 200) to the microphone sock-

et on the receiver.
2. Attach the microphone to a suitable measurement location.
3. Tap the Transmitter button. The Transmitter menu will ap-

pear. The Microphone button can be seen at the bottom right.
Which microphone symbol appears on the Microphone but-
ton depends on the microphone connected.

4. Tap the Microphone button. The Microphone menu will ap-
pear.

5. Tap the Listen to microphone button to start a measure-
ment.

6. Adjust the volume to the current situation.
 − Proceed as explained in section 3.7.3 on page 40.
 − Please note the health hazard warning in the same section.

7. Tap the Switch noise off button when you want to stop the 
measurement.

Exiting the Microphone menu
 ● To return to the Transmitter menu, tap the Transmitter button.
 ● To return to the main view, tap Back.
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4 Settings

4.1 Overview
All settings are managed using the C 200 receiver. The settings 
can be changed at any time. The following menus are available:

 ● Measurement
 ● Device

4.2 Setting options
The settings in the Measurement and Device menus are imple-
mented as follows:

 ● Select
 ● Enable/disable
 ● Set value

Fig. 32: Menu (sample diagram)
Top: Menu item with selected settings
Below: Menu items with enable/disable settings
Bottom: Menu items with set values

Menu items in which settings can be selected or values adjusted 
are indicated by the next symbol.
Menu items in which settings can be enabled/disabled are indi-
cated by a radio button (dot).
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4.2.1 Selecting

Fig. 33: Selecting a setting (sample diagram)
Top: Setting selected
Bottom: Setting not selected

Selected settings are indicated by the tick symbol.
1. In one of the menus, tap on the menu item for which you wish 

to change the setting.
A sub-menu will appear.

2. Tap the relevant setting.
The setting is applied immediately without further confirma-
tion. The receiver goes back up a menu level.
The selected setting is displayed in the higher menu level.

4.2.2 Enabling/disabling

Fig. 34: Enable/disable setting (sample diagram)
Top: Setting enabled
Bottom: Setting disabled

Enabled settings are indicated by a green option button. Disabled 
settings have a grey option button.

 ● In the menu tap on the menu item to be enabled/disabled.
The setting is applied and displayed immediately without a 
confirmation prompt.

4.2.3 Setting a value
Values are set either via a picklist or a numeric keypad.
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Picklist

Fig. 35: Picklist

Values are set using the arrow keys.
1. Tap on an arrow key.

 − The up key increases the value.
 − The down key decreases the value.

2. Apply the settings by pressing Confirm.
The receiver goes back up a menu level.

Numeric keypad

Fig. 36: Numeric keypad

1. Tap the relevant number keys. The selected numbers will be 
displayed via the numeric keypad.

2. Apply the value by pressing Confirm.
The value is rounded up or down if it is outside the value range 
or has an invalid number of decimal places.
The receiver switches back to the parent menu.
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4.3 Settings in the Measurement menu
The settings in the Measurement menu apply to the measure-
ments.

General
Units > Metric

Anglo-American

Interference suppression > high
low
Off

Correlation curve > Positive
Positive & negative

Blocking filter > 60 Hz
50 Hz
Off

Filter basis
Coherence > blue

red
Off

Cross spectrum > blue
red
Off

Spectrum 1 > blue
red
Off

Spectrum 2 > blue
red
Off

Pipe data (Default)
Length > …

Material > AC
Copper
…

Diameter > …

Sound velocity > …

Fig. 37: Measurement menu
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The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Measurement button. The Measurement menu ap-

pears.
3. Adjust the settings as required.

The Measurement menu is divided into three views General, 
Filter basis and Pipe data (Default).
Switch between the views using the Scroll buttons.
The settings options are explained in the next sections.

4. To finish, tap the Back button. The Settings menu appears.
5. Tap Back again to return to the main view.

4.3.1 General

4.3.1.1 Units
Different units can be used for specifying the pipe data.
The options are:

 ● Metric
Length specified in metres (m) and diameter specified in mil-
limetres (mm).

 ● Anglo-American
Length specified in feet (ft.) and diameter specified in inches 
(in.).
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4.3.1.2 Interference suppression
Excessive noise can be suppressed to varying degrees.
The options are:

 ● High
Interference suppression is enabled and has a significant in-
fluence. Some slightly quieter noises may be excluded from 
the correlation.

 ● Low
Interference suppression is enabled. Only very loud noises are 
excluded from the correlation.

 ● Off
Interference suppression is disabled.

SEWERIN recommends: Use the low setting when enabling the 
interference suppression.

4.3.1.3 Correlation curve
The correlation curve can be displayed in different ways.
The options are:

 ● Positive
Displays the magnitude of the positive and negative values. 
The correlation curve is above the x-axis.

 ● Positive & negative
Displays both positive and negative values. The correlation 
curve oscillates around the x-axis.

4.3.1.4 Blocking filter
The blocking filter is an electronic filter which filters out the mains 
frequency of the power supply. This minimises the impact of cur-
rent-carrying electrical lines on the noise.
The options are:

 ● 60 Hz | 50 Hz
Mains frequency that can be selected.

 ● Off
The blocking filter is disabled.
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4.3.2 Filter basis
The noises can be displayed as a graph based on different func-
tions in the Filter menu.
The options are:

 ● Coherence
 ● Cross spectrum
 ● Spectrum 1
 ● Spectrum 2

Up to a maximum of two functions can be displayed at the same 
time.

4.3.2.1 Coherence
Coherence of noises transmitted by transmitters 1 and 2 to the 
receiver.
The options are:

 ● blue | red
Colour that can be selected for the graph.

 ● Off
The function is not displayed.

4.3.2.2 Cross spectrum
Cross power spectrum of noises transmitted from transmitters 1 
and 2 to the receiver.
The options are:

 ● blue | red
Colour that can be selected for the graph.

 ● Off
The function is not displayed.
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4.3.2.3 Spectrum 1 or Spectrum 2
Auto-power spectrum of the noises transmitted from transmitter 
1 or transmitter 2 to the receiver.
The options are:

 ● blue | red
Colour that can be selected for the graph.

 ● Off
The function is not displayed.

4.3.3 Pipe data (Default)
The default values, which are automatically assigned to each 
new pipe section created, are set in the Pipe data (Default) view.
SEWERIN recommends: When selecting default settings, choose 
typical values that commonly occur in your everyday work. For 
example, if you primarily work on cast iron pipes, set the mate-
rial to cast iron.

4.3.3.1 Length
Indicates the length of a pipe section.

 ● Value range: 0.5 m – 3000 m
 ● Decimal places: 1

4.3.3.2 Material
Indicates the material of the pipe in the pipe section.
There is a wide range of materials available for selection.

4.3.3.3 Diameter
Indicates the diameter of the pipe in the pipe section.

 ● Value range: 10 mm – 3000 mm
 ● Decimal places: None

4.3.3.4 Sound velocity
The sound velocity is automatically calculated by the device from 
the diameter and the pipe material.
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The calculated value can be changed. This change is saved tem-
porarily. However, as soon as other settings are selected for the 
diameter or the material, the sound velocity is recalculated.

 ● Value range: 100 m/s – 2000 m/s
 ● Decimal places: None

4.4 Settings in the Device menu
The settings in the Device menu apply to the receiver.

General
Switch off device > 30 min

1 h
3 h
Off

Switch off backlight > 30 s
1 min
15 min
30 min
Off

Detect position O

Automatic brightness O

Brightness > …

Time/Date
Time > …
Date > …

Region
Date format > DD.MM.YY

YYYY-MM-DD

Time format > 12 h
24 h

Language > …
English
…

Service
Information
Calibration

Fig. 38: Device menu
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The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Device button. The Device menu appears.
3. Adjust the settings as required.

The Device menu is divided into the four views General, 
Time/Date, Region and Service.

 − Switch between the views using the Scroll buttons.
The settings options are explained in the next sections.

4. To finish, tap the Back button. The Device menu appears.
5. Tap Back again to return to the main view.

4.4.1 General

4.4.1.1 Switching off the device
The receiver can switch off automatically if it is not operated for 
a specified period of time.

Note:
This function helps save energy. It means that the receiver can 
be used for longer without being recharged.

The options are:
 ● 30 min | 1 h | 3 h
Duration that can be selected.

 ● Off
The receiver does not switch itself off.

4.4.1.2 Switching off the backlight
The touch screen backlight can switch off automatically if it is 
not operated for a specified period of time. The receiver remains 
switched on.
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Note:
This function helps save energy. It means that the receiver can 
be used for longer without being recharged.

The options are:
 ● 30 s | 1 min | 15 min | 30 min
Duration that can be selected.

 ● Off
The backlight does not switch itself off.

4.4.1.3 Detect position
The receiver can detect the alignment of the touch screen. This 
function can be enabled or disabled.

 ● If the function is enabled, the touch screen automatically 
switches off when it is in a vertical position.

 ● As soon as the receiver is in a horizontal position again, the 
touch screen comes back on.

4.4.1.4 Automatic brightness
The brightness of the touch screen can automatically adjust to 
the ambient lighting conditions thanks to the light sensor. This 
means that the touch screen is clearly legible in every situation.
This function can be enabled or disabled.

 ● When this function is disabled, you can set the brightness man-
ually (section 4.4.1.5).

4.4.1.5 Brightness

Note:
Brightness only appears in the menu when the Automatic 
brightness function is disabled.

When the Automatic brightness function is disabled, a per-
manent value can be set for the brightness of the touch screen.
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4.4.2 Time/Date

4.4.2.1 Time
The receiver features an internal clock. The time is used to iden-
tify the measurements.

Note:
The format of the time can be set under Time format in the 
menu.

4.4.2.2 Date
The date is used to identify the measurements.

Note:
The format of the date can be set under Date format in the menu.

4.4.3 Region

4.4.3.1 Date format
The date can be written in various ways.
The options are:

 ● DD.MM.YY
 ● YYYY-MM-DD

The letters refer to the following:
D: day
M: month
Y: year
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4.4.3.2 Time format
The time can be written in various ways.
The options are:

 ● 12 h
12 hour clock

 ● 24 h
24 hour clock

4.4.3.3 Language
The text on the user interface can be displayed in various lan-
guages.
There is a range of languages to choose from.

4.4.4 Service

4.4.4.1 Information
The relevant current technical information is stored in each re-
ceiver.
The following information will be displayed:

 ● Firmware version number
 ● Hardware version number

4.4.4.2 Calibration
The touch screen can be calibrated by the user.
For more detailed information on calibration, please refer to sec-
tion 5.3 on page 63.
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5 Servicing

5.1 Charging the batteries
The batteries of the following components must be charged as 
required:

 ● C 200 receiver (lithium-ion rechargeable battery)
 ● RT 200 transmitter (lithium-ion rechargeable battery)
 ● F8 wireless headphones (NiMH rechargeable battery)

The typical charging time is less than 7.5 hours. The batteries 
are protected against overcharging. The components can, there-
fore, remain connected to the power supply after they are fully 
charged.
Always observe the permitted temperature range during charg-
ing. If the temperature falls below or exceeds the limit values, 
charging stops until the temperature returns to within the permit-
ted range.

There are two ways of charging the components:
 ● All components at the same time in the AC 200 SK 4 case
 ● Each component individually using the AC/DC adapter or ve-
hicle cable

5.1.1 Charging the batteries in the case
The batteries of the components can all be charged simultane-
ously in the AC 200 SK 4 case. The case is connected to the 
power supply using AC/DC adapter L or vehicle cable L.
The AC/DC adapter and vehicle cable are available to buy as 
accessories.
The case contains three connection cables for the components. 
There is a connection socket on the outside of the case for con-
necting to the power supply.
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Fig. 39: AC 200 SK 4 case
White circles: Connection cable
Black arrow: Connection socket (outside)

1. Place the components in the dedicated spaces in the case.
2. Connect the components using the connection cables.
3. Connect the case to the power supply using AC/DC adapter L. 

Charging starts automatically.
After less than 7.5 hours the charging process is complete.

5.1.2 Charging batteries using the AC/DC adapter or vehicle 
cable
The components are connected directly to the power supply for 
charging using AC/DC adapter M4 or vehicle cable M4. Each 
component is charged individually.
The AC/DC adapter and vehicle cable are available to buy as 
accessories.
When the battery is fully charged, the LED on the C 200 receiver 
and the RT 200 transmitters emits a double flash (green).
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5.2 Handling faulty lithium-ion rechargeable batteries
Lithium-ion rechargeable batteries are always considered dan-
gerous goods for transportation. 
The transportation of faulty lithium-ion batteries is only permit-
ted under certain conditions (e.g. must not be transported as air 
freight). Where transportation is permitted (e.g. by road or rail), 
it is subject to strict regulations. Faulty lithium-ion batteries must, 
therefore, always be removed from components before shipping. 
Transportation by road or rail must occur in compliance with the 
current applicable version of the ADR1 regulations.

NOTICE!
Risk of damage when removing lithium-ion batteries
There are parts in the battery compartments of the components 
which can get damaged when removing the batteries.

 ● Lithium-ion batteries must only be removed if there is reason-
able suspicion that they might be faulty.

 ● Only SEWERIN Service personnel or an authorised specialist 
may replace rechargeable batteries.

5.2.1 Identifying faulty batteries
A lithium-ion battery is considered to be faulty if one of the fol-
lowing criteria applies2:

 ● Housing damaged or severely deformed 
 ● Fluid leaking out 
 ● Smell of gas 
 ● Measurable increase in temperature when switched off (more 
than warm to touch) 

 ● Plastic parts melted or deformed
 ● Connection leads melted

1 French abbreviation for: Accord européen relatif au transport interna-
tional des marchandises Dangereuses par Route; English: European 
Agreement concerning the International Carriage of Dangerous Goods 
by Road

2 As per: EPTA – European Power Tool Association
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5.2.2 Removing the battery from the C 200 receiver

NOTICE!
Risk of damage when removing lithium-ion batteries
There are parts in the battery compartment of the receiver which 
can get damaged when removing the batteries.

 ● Always read section 5.2 and section 5.2.1 before removing 
the batteries.

 ● Only remove the batteries if there is reasonable suspicion that 
they might be faulty.s

Fig. 40: Back of the C 200 receiver
White circles: Screws of battery compartment cover

The batteries are in the battery compartment. The battery com-
partment is sealed with the battery compartment cover.

The receiver must be switched off.
1. Undo the four screws securing the battery compartment cover.
2. Lift off the battery compartment cover with extreme care.



62 │ 5 Servicing

NOTICE! Risk of damage from electrostatic discharge
There is an aerial in the battery compartment cover. That is why 
the battery compartment cover has an electrical connection (ca-
ble) from the inside into the device interior.

 ● Ensure that the cable does not get severed.
 ● Never touch the solder joint on the inside of the battery com-
partment cover.

3. Disconnect the electrical supply to the faulty battery by pulling 
off the white plug.
Never sever the cable.

4. Remove the battery.
5. Screw the battery compartment cover back on.

5.2.3 Removing the battery from the RT 200 transmitter
The battery is located directly inside the device.

NOTICE! Risk of damage
Components are at risk of damage when opening the housing.

 ● It is essential to read section 5.2 and section 5.2.1 before re-
moving the battery.

There should be no microphone connected to the transmitter.
1. Undo the four screws on the bottom section of the housing.
2. Carefully lift off the bottom section of the housing.

The top section and the bottom section of the housing are 
connected by means of the cable from the battery to the cir-
cuit board.

3. Disconnect the defective battery from the electricity supply by 
pulling out the white connector on the circuit board.
Do not under any circumstances rip out the cable.
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4. The battery is fixed in place in the bottom section of the hous-
ing by means of a retaining plate. Undo the three screws on 
the retaining plate.

5. Remove the battery.
6. Screw down the retaining plate again.
7. Screw the bottom section of the housing to the top section 

again.

5.3 Calibrating the touch screen
The touch screen of the C 200 receiver is calibrated when it 
leaves the factory. If the touch screen responds incorrectly when 
operated, it can be recalibrated.
Calibration involves two stages, which occur automatically in suc-
cession. Firstly the areas are reset. Then the reset areas need 
to be confirmed.

Note:
If the calibration process is interrupted, the touch screen may be 
so misaligned that it cannot be used.

 ● Never switch the receiver off during the calibration process.
 ● Always use a touch pen for calibration.
 ● Be extremely careful.

The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Device button. The Device menu appears.
3. Switch to the Service view (Device 4/4).
4. Tap Calibration. The calibration begins.
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5. Follow the instructions.
 − The individual steps must be completed within a limited 
time. If the step is not completed within this time, the cali-
bration process will be aborted.

 − The active area is marked with crosshairs. Non-active ar-
eas are grey.

 − Blue crosshairs: Set area
 − Red crosshairs: Confirm area

 − Try to hit the centre of the active area as accurately as 
possible.

Once the screen has been successfully calibrated, the re-
ceiver automatically switches back to the Service view.

5.4 Care
All that is necessary to care for the components is to wipe them 
down with a damp cloth.
SEWERIN recommends: Always remove significant contamina-
tion immediately.

5.5 Maintenance
SEWERIN recommends: Have the system serviced regularly by 
SEWERIN Service or an authorised professional. Only regular 
servicing can ensure that the system is always ready for use.
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6 Appendix

6.1 Technical data

6.1.1 C 200 receiver

Device data

Dimensions (W x D x H) 225 x 62 x 155 mm
Weight 1.2 kg
Material Polycarbonate (housing)

Certificates

Certificate FCC, CE, IC, MIC
Marking Contains:

FCC ID WSP-EZ1300102
IC 7994A-EZ1300102

Features

Display 5.7” TFT display, 640 x 480 pixels (VGA), 
LED backlight

Interface Micro USB
Data memory 90 MB (internal)
Processor 32-bit RISC processor, digital signal 

processor
Control Touch screen, ON/OFF key

Operating conditions

Operating temperature -20 °C – +60 °C
Storage temperature -25 °C – +50 °C (briefly +60 °C)
Humidity 15% – 90% r.h., non-condensing
Protection rating IP65/IP67
Non-permitted operating 
environments

In potentially explosive areas
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Power supply

Power supply 2 x lithium ion batteries (rechargeable) 
[1357-0002]

Operating time, typical > 10 h 
Battery power 2 x 24 Wh
Charging time < 7.5 h
Charging temperature 0 °C – +40 °C
Charging voltage 12 V
Charging current 1.2 A
Charger AC/DC adapter L (charge in case)

Data logging

Filter automatic or manual
Sampling rate 16 bit, 24 kHz

Data transmission

Near-field radio SDR (SEWERIN 
Digital Radio)

Transmission frequency 433.9/434.4 MHz
444.5500/444.9875 MHz
458.5125 /458.7875 MHz
468.5/469.6 MHz

2.408 – 2.476 
GHz, 38 channels

Radio range > 500 m > 2 m
Transmission bandwidth 0 – 5 kHz 0 – 12 kHz
Power 500 mW 10 mW 

Additional data

Attachment option Quick-release fastener (Tenax)
Transport Case AC 200 SK4
Shipping instructions UN 3481

lithium ion batteries contained in equipment 
or lithium ion batteries packed with equipment 
net weight of battery/batteries: 0.196 kg 
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6.1.2 RT 200 transmitter

Device data

Dimensions (W x D x H) 115 × 115 × 68 mm
115 × 115 × 244 mm with aerial

Weight 430 g (with aerial)
Material Polycarbonate (housing)
Models country-specific

Certificates

Certificate FCC, CE, IC
Marking  – everywhere apart from USA: 

Contains: 70TX-D2
 – USA only: 
Contains: 70TX-D, FCC-ID:PUX70TX-D

Features

Signal light 1 LED red/green for operating status
3 LEDs green for filter

Interface internal (USB)
Processor DSP, 16 bit / 120 MHz
Control membrane keypad

Operating conditions

Operating temperature -20 °C – +60 °C
Storage temperature -25 °C – +50 °C (briefly +60°C)
Humidity 15% - 90% r.h. non-condensing
Protection rating IP65

IP67 with aerial
Non-permitted operating 
environments

In potentially explosive areas
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Power supply

Power supply lithium ion battery (rechargeable) 
[1357-0002], built-in 

Operating time, minimum > 8 h (23 °C)
Battery power 24 Wh
Charging time < 6 h
Charging temperature 0 °C – +45 °C
Charging voltage 12 V
Charging current 1.2 A
Charger AC/DC adapter L (charge in case)

Measurement

Filter  – 3 bandpasses: 
0 – 500 Hz, 0 – 4000 Hz, 200 – 4000 Hz

 – Notch filter
Sampling rate 16 bit, 48 kHz
Measurement ranges 0 – 1 Vrms
Sensitivity automatic amplification: 

163 levels (-17.25 – +89 dB)

Data transmission

Transmission frequency international: 433.9/434.4 MHz
France: 444.5500/444.9875 MHz
UK: 458.5125/458.7875 MHz
USA: 468.5/469.6 MHz

Radio range > 500 m
Transmission bandwidth 5 kHz

0 – 4 kHz NF
4 – 5 kHz Control signals

Communication analogue
Power 500 mW

GPS

Accuracy 2.5 m CEP
Aerial integrated

Additional data

Shipping instructions UN 3481
lithium ion batteries contained in equipment 
or lithium ion batteries packed with equipment
net weight of battery/batteries: 0.098 kg



 6 Appendix │ 69

6.1.3 UM 200 universal microphone

Device data

Dimensions (H × Ø) 123 x 45 mm (without cable)
Weight 1055 g
Material Stainless steel
Models 3 cable lengths available

Features

Signal light 2 LEDs white (each 15 cd)

Operating conditions

Operating temperature -20 °C – +80 °C
Storage temperature -25 °C – +80 °C
Protection rating IP68
Non-permitted operating 
environments

In aggressive media
In potentially explosive areas

Measurement

Measurement principle piezo microphone (analogue)
Sensitivity approx. 10 V/g (20 – 1000 Hz)

Additional data

Type of cable 6-pin, outer diameter 6.2 mm, 
tensile strength > 3000 N

Cable length 1.3 m / 2.8 m / 6 m
Transport Case AC 200 SK4
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6.1.4 HY 200 hydrophone

Device data

Dimensions (W × H) 55 × 115 mm
Weight 700 g (without cable)
Material Stainless steel

Operating conditions

Operating temperature -20 ºC – +80 ºC
Storage temperature -25 ºC – +80 ºC
Atmospheric pressure water pressure up to 16 bar
Protection rating IP68
Non-permitted operating 
environments

in liquids other than water
In aggressive media
In potentially explosive areas

Power supply

Power supply via RT 200

Measurement

Filter 20 Hz high pass
Measurement principle piezo microphone (analogue)

Data transmission

Communication analogue via cable with RT 200

Additional data

Type of cable 6-pin, outer diameter 6.2 mm
Cable length 2.9 m
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6.2 Symbols on the touch screen of the C 200 receiver
The following tables provide an overview of what the main sym-
bols represent. The symbols can also occur in combination dur-
ing the program sequence. Many symbols on the touch screen 
can be displayed in different ways:

 ● Coloured symbol
Function enabled, system component connected, etc.

 ● Symbol greyed out
Function disabled, system component not connected, etc.

Symbol Significance
Confirm

Cancel

Back

 
Scroll

Receiver

Transmitter

Universal 
microphone
Microphone 
unknown
Headphones

Measurement 
settings
Device settings

Start 
measurement

Symbol Significance
Stop 
measurement
Reset

Add

Interference 
suppression
Quality of peak

Duration of 
measurement
Automatically 
calculated filter
Manually set filter

Rechargeable 
battery
Battery fully 
charged
Battery flat

Battery charging
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Symbol Significance
Volume

Volume low

Volume high

Brightness

Brightness low

Brightness high

Light on 
microphone
File

Charge

Filter by date

Save

Clear

Symbol Significance
Selected

Next

 
Move

Noises from 
transmitter
Noises from 
transmitter 1
Noises from 
transmitter 2
No noises from 
transmitter
Listen to 
microphone
Signal strength

GPS position 
known
GPS position 
unknown
Crosshairs
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6.3 Significance of LED signals

6.3.1 C 200 receiver
The LED indicates the operating status.

Colour Type of 
signal

Activation 
(repeat)

Significance

Green Light 
permanently 
on

 ● C 200 switched on

Flashing 0.1 s on > 0.9 s 
off
(ongoing)

 ● Battery charging

Double 
flash

0.1 s on > 0.1 s 
off > 0.1 s on > 
0.7 s off
(ongoing)

 ● Battery is fully 
charged

Red Light 
permanently 
on

 ● C 200 switched on
 ● Undervoltage: Bat-
tery needs charged

Flashing 0.1 s on > 0.9 s 
off
(ongoing)

 ● Error when charging 
battery (temperature 
below or above per-
mitted charging tem-
perature)

Key: 
> subsequently
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6.3.2 RT 200 transmitter
The large LED between the two keys indicates operating statuses 
(see table below).
The three small LEDs above the filter key indicate the bandpass 
setting.

Colour Type of 
signal

Activation 
(repeat)

Significance

Green Light 
permanently 
on

 ● RT 200 switched on

Flashing 0.1 s on > 0.9 s 
off
(ongoing)

 ● Battery charging

Double 
flash

0.1 s on > 0.1 s 
off > 0.1 s on > 
0.7 s off
(ongoing)

 ● Battery is fully 
charged

Red Light 
permanently 
on

 ● RT 200 switched on
 ● Undervoltage: Bat-
tery needs charged

Flashing 0.1 s on > 0.9 s 
off
(ongoing)

 ● Error when charging 
battery (temperature 
below or above per-
mitted charging tem-
perature)

Key: 
>  subsequently
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6.4 Troubleshooting

Problems with the receiver

Problem Possible cause Corrective action
Touch 
screen black

Backlight has 
switched off after 
specified time

 ● Touch the screen > 
display will light up 
again

 ● If necessary change 
backlight time (setting: 
Switch off backlight)

Battery flat  ● Recharge battery
Position detection 
enabled; receiver in 
incorrect position of 
use

 ● Change the position of 
use of the receiver

 ● If necessary disable 
position detection (set-
ting: Detect position)

Touch screen or re-
ceiver faulty

 ● Contact SEWERIN 
Service
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6.5 Accessories

Part Order number
F8 wireless headphones EZ13-18000
HY 200 hydrophone (set) HY20-S0001
UM 200 microphone protector EM20-Z0201
M10 tripod 4000-0966
Triangle 200 carrying strap 3209-0022
Lap belt carrying system EA20-Z1000
Padded hand loop 3209-0017
AC/DC adapter L 12 V= LD26-10000
Vehicle cable L 12 V= ZL05-10200

Other accessories are available for the system. Please contact 
our SEWERIN sales department for further information.

6.6 Declaration of conformity
Hermann Sewerin GmbH hereby declares that the C 200 receiver 
and RT 200 transmitter fulfil the requirements of the following 
guideline:

 ● 2014/53/EU
The complete declaration of conformity can be found online.

6.7 FCC Compliance Statements
The device has been tested and found to comply with the lim-
its for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protec-
tion against harmful interference when the device is operated 
in a commercial environment. The device generates, uses, and 
can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this device in 
a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his 
own expense.
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6.8 Licences in the EEA
The RT 200 transmitter may only be used in the following coun-
tries of the European Economic Area (EEA) and only at the cor-
responding frequencies.

Note:
Also refer to the advice regarding near-field radio in section 1.5.

Austria 433.9000/434.4000 MHz

Belgium 455.8100/456.8100 MHz

Cyprus 433.9000/434.4000 MHz

Czech Republic 433.9000/434.4000 MHz

Denmark 433.9000/434.4000 MHz

Estonia 433.9000/434.4000 MHz

Finland 433.9000/434.4000 MHz

France 444.5500/444.9875 MHz

Germany 433.9000/434.4000 MHz

Greece 433.9000/434.4000 MHz

Hungary 433.9000/434.4000 MHz

Iceland 433.9000/434.4000 MHz

Ireland 433.9000/434.4000 MHz

Italy 433.9000/434.4000 MHz

Liechtenstein 433.9000/434.4000 MHz

Lithuania 433.9000/434.4000 MHz

Luxembourg 433.9000/434.4000 MHz

Netherlands 433.9000/434.4000 MHz

Norway 433.9000/434.4000 MHz

Poland 433.9000/434.4000 MHz

Romania 433.9000/434.4000 MHz

Spain 433.9000/434.4000 MHz

Sweden 433.9000/434.4000 MHz

Switzerland 433.9000/434.4000 MHz

UK 458.5125/458.7875 MHz
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6.9 Note about the firmware (open source software)
The firmware is based on open source software. The source 
code is provided in accordance with the licence terms for this 
open source software (GPL / LGPL). Hermann Sewerin GmbH 
stresses that it is not responsible for the source code and it does 
not form part of the services due.
The source code is available on request at cost price by emailing 
info@sewerin.com.
The full licence terms can be found online (www.sewerin.com) 
under Info centre > Downloads.

6.10 Advice on disposal
The European Waste Catalogue (EWC) governs the disposal of 
appliances and accessories.

Description of waste Allocated EWC waste code
Device 16 02 13

disposable battery, 
rechargeable battery

16 06 05 / 20 01 34

End-of-life equipment
Used equipment can be returned to Hermann Sewerin GmbH. 
We will arrange for the equipment to be disposed of appropriately 
by certified specialist contractors free of charge.
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7 Index

A
Acoustic leak detection  42
Aerial  17
Auto 1 or Auto 2  32
automatic power off  9

B
Bandpass  16
Blocking filter  50
Brightness  55

automatic  55

C
Calculations, number of  14
Calibration  57, 63
Coherence  51
Communication  4
Correlation curve  34

Display  50
Cross spectrum  51
Current filter (button)  32

D
Data transmission  4
Date  56
Date format  56
Defective lithium-ion rechargeable bat-

tery  60
Detect position  55
Diameter  52

E
Enable/disable  46

F
Filter

Adjusting  36
Applying  37
Blocking filter  50
Button  14
Date  29
Opening menu  35
Options on the receiver  32

Overview  20
Selecting  35
Transmitter options  16

Filter basis  51
Frequency graph  33

H
High pass  17
Hydrophone  19

I
Information  57
Interference suppression

Active  15
Operating principle  15

L
Language  57
LED  7, 17

Significance  73
Length  52
Licence  77
Light key  17
Light sensor  7
Listening to noise  38
Lithium-ion rechargeable battery

Identifying a defect  60
Removing  61, 62
Transport regulations  60

Low pass  17

M
Main view  10
Manual  32
Marker  13

Moving  38
Material  52
Measurement

After configuring pipe sections  26
Continuing  26
Deleting  30
Filtering  29
Loading  28
Noises  44
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Preparing  22
Repeating  27
Saving  27
Starting  26
Steps (overview)  22
Stopping  27

Microphone
Connecting  20

Microphone function  42
Minimum noise level  43

N
Near-field radio  4
Noise level  43
Noise measurement  44

P
Peak  34
Pipe data

Adjusting  25
Default  52

Pipe section
Adding  24
Configuring  22
Deleting  24
Number  23

Power supply  21

Q
Quality of peak  34

R
Radio connection

Overview  4
When listening  38

Receiver  6
Carrying the system  8
Connectors  8
Ports  8
Switching off  9
Switching on  9
Switch off backlight  9

Rechargeable battery see also Lithium-
ion rechargeable battery

Charging  58
Result

Display  10
Optimising  31

S
SDR (Sewerin Digital Radio)  4
Select  46
Settings

Button  14
Device  53
Enable/disable  46
Measurement  48
Options  45
Select  46
Set value  46

Set value  46
Sound velocity  52
Spectrum 1 or spectrum 2  52
Switching off backlight  54
Switch off device  54
Symbols  71
System

Components (overview)  5
Preparing  22

T
Time  56
Time format  57
Touch screen  6

Calibrating  63
Transmitter  16

Ports  16
Selecting  41
Switching off  18
Switching on  18

U
Units  49
Universal microphone  18

V
Volume  40, 43
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